Through this lecture students will be able to:

Be familiar with Microsoft Excel Basics

Perform all tasks related to editing worksheet

Apply formatting for cells and sheets
Microsoft Office 2019

MS Office include many applications

Mainly it include the three popular applications
Office applications

Microsoft Excel
Microsoft Word
Microsoft PowerPoint
Microsoft OneNote
Microsoft Outlook
Microsoft Publisher
Microsoft Access
Microsoft InfoPath
Microsoft applications are comprised of mainly the Office suite of applications that support various productivity needs on both Microsoft Windows and Mac OS operating systems.
1. Identify general needed shortcuts
2. Explore MS excel window
3. Navigate between different cells
4. Manage the workbook
5. Formatting for cells and sheets (paper)
How to pin Microsoft Excel to taskbar?

1. Click the Start button.
2. Locate the application you want to pin to the taskbar and right-click on it.
3. In the menu that appears, hover your cursor over "More"
4. Click on "Pin to taskbar"
How to start Microsoft Excel?

1. Click on Microsoft Excel.
2. Select desired option
   (NEW = Ctrl +N
   or   OPEN= Ctrl +O )
Keyboard Shortcuts

- General:
  - New Workbook (Ctrl+N)
  - Open a Workbook (Ctrl+O)
  - Save a Workbook (Ctrl+S)
  - Print a Workbook (Ctrl+P)
  - Close a Workbook (Ctrl+W)
  - Undo (Ctrl+Z)
  - Redo (Ctrl+Y)
  - Switch between apps (Alt + Tab)

- Editing:
  - Cut (Ctrl+X)
  - Copy (Ctrl+C)
  - Paste (Ctrl+V)
Microsoft Excel Ribbon is the row of **tabs** and **icons** at the top of the Excel window. It allows you to quickly find and use **commands** for completing a certain task. It looks like a kind of complex Toolbar.
The Home contain the following Icon
1. Clipboard (CUT, COPY, PASTE)
2. Font
3. Alignment
4. Number
5. Style
6. Cell
7. Editing

Home

10/12/2022

3rd Year Dent. Tech. Dept.
Font (type and size)
Style (Underline, Italics, and Bold) or (Ctrl+U), (Ctrl+I), (Ctrl+B)
Colours (fill colours)
Borders:
Learning MS Excel Basics: Entering Value

This is the default sheet
To enter data: Select the cell, Start typing

Important tips:
1. To move to the next column (press Tab key)
2. To move to the next row (press Enter key)
3. To start new line in the same Column (press Alt + Enter) you can use the arrows key to select the desired cell.
Learning MS Excel Basics:

Saving Workbook:
- File > save as > specify the location and modify the file’s name if required.

Closing Workbook:  CTRL+W  or  CTRL+F4

Open workbook:  CTRL+O
Managing worksheets

For Worksheets we can:

1. Insert one or more Worksheet
2. Rename it
3. Change its Tab color
4. Rearrange them in any required order
5. Delete unrequired one
6. Duplicate (copy) or move it before / after any Worksheet or at the end
7. Hid and Unhide certain Worksheet.
1. Identify general needed shortcuts
2. Explore MS excel window
3. Navigate between different cells
4. Manage the workbook
5. Formatting for cells and sheets
Cell: can contain a **Number**, **Logic** **Date**, **text** or **formula**

**Worksheet:** a *single* spreadsheet that contains **cells** organized by **rows** and **columns**

**Workbook:** an *Excel file* that contains one or more **worksheets**
Saving Workbook:
• File > save as > specify the location and modify the file’s name if required.

Closing Workbook: CTRL+W

Open workbook: CTRL+O
Managing worksheets

1. Identify how to manage worksheet
2. Editing worksheets
Activate the cell and add data
- Insert formula:

Formula in Excel (Insert data)

10/12/2022

Formula Bar: Any formula should start with = sign
<table>
<thead>
<tr>
<th>الاسم</th>
<th>الشعبة</th>
<th>الفصل الثاني</th>
<th>السنة</th>
<th>النقط</th>
<th>الفصل الأول</th>
<th>السنة</th>
<th>النقط</th>
</tr>
</thead>
<tbody>
<tr>
<td>احمد مؤيد جاسم</td>
<td>A</td>
<td>9</td>
<td>8.5</td>
<td>5.5</td>
<td>3.5</td>
<td>9</td>
<td>6</td>
</tr>
<tr>
<td>ابراهيم بشارة عبد العزيز</td>
<td>B</td>
<td>5.5</td>
<td>17</td>
<td>9</td>
<td>9</td>
<td>16</td>
<td>8</td>
</tr>
<tr>
<td>اسراء احمد قاسم</td>
<td>B</td>
<td>7.5</td>
<td>8</td>
<td>8</td>
<td>7.5</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>اسراء خالد البانسي</td>
<td>A</td>
<td>8</td>
<td>7</td>
<td>7</td>
<td>8</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>امنة فارس محمودي احمد</td>
<td>B</td>
<td>9</td>
<td>16</td>
<td>9</td>
<td>7</td>
<td>19</td>
<td>7</td>
</tr>
</tbody>
</table>

* используется CUT & PASTE لنقل البيانات (مقطع)*

* Delete لحذف البيانات*
Sorting in ascending, descending numeric order
Creating new Worksheet:
- How many sheet are provided in the workbook by default?
- Now in order to add more sheets:
  - Right-click on sheet tabs
  - Select Insert
  - An insert dialog will display with selected worksheet

Copy Worksheet:
- Right click on sheet name,
- Select move or copy
  - HINT: you need to add some data to check the copying perfectly

Hiding and Unhide Worksheet:
- Find how can we hide worksheet and unhide it

Deleting Worksheet:
- Find how can we delete worksheet
Editing Worksheet: Rows and Columns

Columns run vertically
MS Excel is providing columns
From A to XFD

Rows run horizontally
MS Excel is providing rows
From 1 to 104876

Cell can be identified using columns and rows

What is the value of the Cell A3? 30

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Products price</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sale percentage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>30</td>
<td>0.15</td>
<td>4.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>50</td>
<td>0.5</td>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10/12/2022
3rd Year Dent. Tech. Dept.
25
To select Row
- Click on the row heading

To select a range of adjacent rows
- Click on the first row heading.
- Drag to highlight through to the last row heading

To select a range of non-adjacent rows
- Click on the first row heading or range of rows.
- Hold the Ctrl key down and continue highlighting additional row headings.

To select column
- Click on the column heading

To select a range of adjacent columns
- Click on the first column heading.
- Drag to highlight through to the last column heading

To select a range of non-adjacent columns
- Click on the first column heading or range of columns.
- Hold the Ctrl key down and continue highlighting additional column headings.
Editing Worksheet: Modify Rows height and Columns width

• To modify the Column width
  • Click on the column heading(s) to modify.
  • On the Home tab, in the Cells group, click the Format button.
  • To modify column width to a specified value, click Column Width and enter a width, then click OK.
  • To modify column width to optimal width, click Auto-fit Column Width.

• To modify the Row height
  • Click on the row heading(s) to modify.
  • On the Home tab, in the Cells group, click the Format button.
  • To modify row height to a specified value, click Row Height and enter a row height, then click OK.
  • To modify row height to optimal height, click Auto-fit Row Height.
Why?
- To keep column headings visible regardless of where you scroll in your sheet.

How?
- Select the column immediately to the right of the column to freeze.
- On the View tab, in the Window group, click the Freeze Panes arrow.
- Click the Freeze Panes button
Exercise:

- Students should create their first excel sheet by adding a table as the following and find the total using the formula bar.

<table>
<thead>
<tr>
<th>Name</th>
<th>Marks scored in Computer</th>
<th>Marks scored in medical chemistry</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mohammed</td>
<td>78</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Ahmed</td>
<td>80</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Omar</td>
<td>96</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Ali</td>
<td>86</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>Mazin</td>
<td>49</td>
<td>89</td>
<td></td>
</tr>
</tbody>
</table>
The list is showing the different types that cell can handle.

In order to modify the cell type, select the cell and then number group in the home tab.
• Select text,
• Modify the font type and size from **Font Group**
Formatting Cells: Text-decoration and setting text color

To get the Format Cell Dialog:
Right click on cell and select format cell, font tab

1. Modify font style
2. Effects

• Change the text color
To rotate a cell:
- Display the same format cell dialog
- Select alignment tab
- Modify the orientation

Change the text alignment:
• To change the background color:
  ▫ Display the format cell
  ▫ Go to Fill tab

• To add borders:
  ▫ Display the format cell
  ▫ Go to Border tab
- Is to combine two or more cells into a single cell.
- How? Select and merge
Problem?

Solution:

- Merge cells
- Wrap text
- Shrink to fit

The cell content is:
Ahmed Abdullah Ali

HOWEVER, the cell is only displaying (Ahmed A)

Format cell dialog
Alignment Tab
Control Text

10/12/2022
3rd Year Dent. Tech. Dept.
To set the layout for printing:
Go to page layout tab
Sheet options group
• Add header and footer to add information to the workbook.

Page layout
Sheet options
Header/footer
- Margins: are the unprinted area the page sides
- All margins are fixed for the same pages.

Change page orientation,
1. Portrait
2. Landscape

10/12/2022 3rd Year Dent. Tech. Dept.
• Page break: Identify the printed part of each page
• Background for the entire worksheet
• How?
enables you to format a range of values so that values outside certain limits, are automatically formatted.

Select the column in which you want to apply the conditional formatting.
References:

- ICS skills, New Ecdl Syllabi, 2013
Through this lecture students will be able to:

- Be familiar with Microsoft Excel Basics
- Perform all tasks related to editing worksheet
- Apply formatting for cells and sheets
Microsoft Office 2019

MS Office include many applications

Mainly it include the three popular applications
Office applications

Microsoft Excel
Microsoft Word
Microsoft PowerPoint
Microsoft OneNote
Microsoft Outlook
Microsoft Publisher
Microsoft Access
Microsoft InfoPath
Microsoft applications are comprised of mainly the Office suite of applications that support various productivity needs on both Microsoft Windows and Mac OS operating systems.
1. Identify general needed shortcuts
2. Explore MS excel window
3. Navigate between different cells
4. Manage the workbook
5. Formatting for cells and sheets (paper)

1. ستتمكن الطلبة من:
   معرفة الاختصارات العامة المطلوبة
   
   التفاعل مع نافذة مايكروسوفت اكسل
   
   كيفية التنقل بين الخلايا المختلفة
   
   إدارة المصنف
   
   تنسيق الخلايا والأوراق
How to pin Microsoft Excel to taskbar?

1. Click the **Start button**.
2. Locate the application you want to pin to the taskbar and **right-click** on it.
3. In the menu that appears, hover your cursor over **"More"**
4. Click on **"Pin to taskbar"**
How to start Microsoft Excel?

1. Click on Microsoft Excel.
2. Select desired option (NEW = Ctrl + N or OPEN = Ctrl + O )
Keyboard Shortcuts

- **General:**
  - **New Workbook** (Ctrl+N)
  - **Open a Workbook** (Ctrl+O)
  - **Save a Workbook** (Ctrl+S)
  - **Print a Workbook** (Ctrl+P)
  - **Close a Workbook** (Ctrl+W)
  - **Undo** (Ctrl+Z)
  - **Redo** (Ctrl+Y)
  - **Switch between apps** (Alt + Tab)

- **Editing:**
  - **Cut** (Ctrl+X)
  - **Copy** (Ctrl+C)
  - **Paste** (Ctrl+V)
Learning MS Excel Basics: Explore Window
Microsoft Excel Ribbon is the row of tabs and icons at the top of the Excel window. It allows you to quickly find and use commands for completing a certain task. It looks like a kind of complex Toolbar.
The Home contain the following Icon
1. Clipboard (CUT, COPY, PASTE)
2. Font
3. Alignment
4. Number
5. Style
6. Cell
7. Editing
Font Attributes

Font (type and size)
Style (Underline, Italics, and Bold) or (Ctrl+U), (Ctrl+I), (Ctrl+B)

Colours (fill colours)
Borders:

Font Color

11/2/22

3rd Year Dent. Tech. Dept.
Learning MS Excel Basics: Entering Value

This is the default sheet
To enter data: Select the cell, Start typing

Important tips:
1. To move to the next column (press Tab key)
2. To move to the next row (press Enter key)
3. To start new line in the same Column (press Alt + Enter) you can use the arrows key to select the desired cell.
Learning MS Excel Basics:

Saving Workbook:
- File > save as > specify the location and modify the file’s name if required.

Closing Workbook:  CTRL+W       or      CTRL+F4

Open workbook:     CTRL+O
Managing worksheets

For Worksheets we can:

1. Insert one or more Worksheet
2. Rename it
3. Change its Tab color
4. Rearrange them in any required order
5. Delete unrequired one
6. Duplicate (copy) or move it before / after any Worksheet or at the end
7. Hide and Unhide certain Worksheet.
1. Identify general needed shortcuts
2. Explore MS excel window
3. Navigate between different cells
4. Manage the workbook
5. Formatting for cells and sheets
Cell: can contain a **Number**, **Logic Date**, **text** or **formula**

Worksheet: a **single** spreadsheet that contains **cells** organized by **rows** and **columns**

Workbook: **Excel file that contains one or more worksheets**
Saving Workbook:
• File > save as > specify the location and modify the file’s name if required.

Closing Workbook: CTRL+W

Open workbook: CTRL+O
Managing worksheets

1. Identify how to manage worksheets
2. Editing worksheets
Formula in Excel (Insert data)

- Activate the cell and add data
- Insert formula:

```
=D4+E4+J3
```

![Excel formula example](image)
<table>
<thead>
<tr>
<th>اسم</th>
<th>شعبة</th>
<th>ت</th>
<th>الفترة</th>
<th>الدرجة الأولى</th>
<th>الدرجة الثانية</th>
</tr>
</thead>
<tbody>
<tr>
<td>أحمد مصطفى جاسم</td>
<td>A</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ابتهال بشار عابد فهد</td>
<td>B</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>اسراء احمد قاسم باني</td>
<td>B</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>اسراء خالد الياس خضر</td>
<td>A</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>امنة فارس حمودي بحى</td>
<td>B</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Dinno University*  
*Dentistry Technology Department*  
*Editing Worksheet:*

Select CUT & Paste

Delete
• Sorting in ascending, descending numeric order
Creating new Worksheet:
- How many sheet are provided in the workbook by default?
- Now in order to add more sheets:
  - Right-click on sheet tabs
  - Select Insert
  - An insert dialog will display with selected worksheet

Copy Worksheet:
- Right click on sheet name,
- Select move or copy
  - HINT: you need to add some data to check the copying perfectly

Hiding and Unhide Worksheet:
- Find how can we hide worksheet and unhide it

Deleting Worksheet:
- Find how can we delete worksheet
**Editing Worksheet: Rows and Columns**

Columns run vertically. MS Excel is providing columns from A to XFD.

Rows run horizontally. MS Excel is providing rows from 1 to 104876.

Cell can be identified using columns and rows.

What is the value of the Cell A3? **30**

---

**11/2/22**

3rd Year Dent. Tech. Dept. 25
**Editing Worksheet: Select Rows and Columns**

- **To select Row**
  - Click on the row heading

- **To select a range of adjacent rows**
  - Click on the first row heading.
  - Drag to highlight through to the last row heading

- **To select a range of non-adjacent rows**
  - Click on the first row heading or range of rows.
  - Hold the Ctrl key down and continue highlighting additional row headings.

- **To select column**
  - Click on the column heading

- **To select a range of adjacent columns**
  - Click on the first column heading.
  - Drag to highlight through to the last column heading

- **To select a range of non-adjacent columns**
  - Click on the first column heading or range of columns.
  - Hold the Ctrl key down and continue highlighting additional column headings
Editing Worksheet: Modify Rows height and Columns width

- To modify the Column width
  - Click on the column heading(s) to modify.
  - On the Home tab, in the Cells group, click the Format button.
  - To modify column width to a specified value, click Column Width and enter a width, then click OK.
  - To modify column width to optimal width, click Auto-fit Column Width.

- To modify the Row height
  - Click on the row heading(s) to modify.
  - On the Home tab, in the Cells group, click the Format button.
  - To modify row height to a specified value, click Row Height and enter a row height, then click OK.
  - To modify row height to optimal height, click Auto-fit Row Height.
• Why?
  ▫ To keep column headings visible regardless of where you scroll in your sheet.

• How?
  ▫ Select the column immediately to the right of the column to freeze.
  ▫ On the View tab, in the Window group, click the Freeze Panes arrow.
  ▫ Click the Freeze Panes button
Exercise:

- Students should create their first excel sheet by adding a table as the following and find the total using the formula bar.

<table>
<thead>
<tr>
<th>Name</th>
<th>Marks scored in Computer</th>
<th>Marks scored in medical chemistry</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mohammed</td>
<td>78</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Ahmed</td>
<td>80</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Omar</td>
<td>96</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Ali</td>
<td>86</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>Mazin</td>
<td>49</td>
<td>89</td>
<td></td>
</tr>
</tbody>
</table>

11/2/22
3rd Year Dent. Tech. Dept.
Formatting Cells: Setting Cell type

The list is showing the different types that cell can handle.

In order to modify the cell type, select the cell and then number group in the home tab.
Formatting Cells: Setting fonts

- Select text,
- Modify the font type and size from **Font Group**
Formatting Cells: Text-decoration and setting text color

To get the Format Cell Dialog:
Right click on cell and select format cell, font tab

1. Modify font style
2. Effects

- Change the text color

11/2/22
3rd Year Dent. Tech. Dept.
To rotate a cell:

1. Display the same format cell dialog
2. Select alignment tab
3. Modify the orientation

Change the text alignment:
To change the background color:
- Display the format cell
- Go to Fill tab

To add borders:
- Display the format cell
- Go to Border tab
Is to combine two or more cells into a single cell.

How? Select and merge

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4:00:00 AM</td>
<td>$89.20</td>
<td>12:00:00 AM</td>
<td></td>
<td>1.25E+01</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>$9.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Problem:

The cell content is:
Ahmed Abdullah Ali
HOWEVER, the cell is only displaying (Ahmed A)

Solution:

- Merge cells
- Wrap text
- Shrink to fit

Format cell dialog
Alignment Tab
Control Text
Formatting Sheets: Options for printing purpose

To set the layout for printing:
Go to page layout tab
Sheet options group
• Add header and footer to add information to the workbook.
Margins: are the unprinted area the page sides
All margins are fixed for the same pages.

Change page orientation,
1. Portrait
2. Landscape
• Page break: Identify the printed part of each page
• Background for the entire worksheet
• How?
• enables you to format a range of values so that values outside certain limits, are automatically formatted.

Select the column in which you want to apply the conditional formatting.
References:

- ICS skills, New Ecdl Syllabi, 2013
Learning MS Excel Basics: Explore Window
Displays the current cell mode. One of the following modes is displayed:

1. **Ready** to indicate a general state.

2. **Enter** to indicate content entry mode. It is displayed when you select a cell and **start typing**, or when you press F2 **twice**.

3. **Edit** to indicate in-cell editing mode. It is displayed when you **double-click** a cell, or when you press **F2** so that you can enter or edit data in a cell.

4. **Point** to indicate formula cell selection mode. It is displayed when you start a **formula** and then click the **cells** that you want **to include** in the formula.
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>=COUNTIF(4:4,&quot;&quot;)</td>
<td>16384</td>
<td>عدد الأعمدة</td>
</tr>
<tr>
<td>2</td>
<td>=COUNTIF(D:D,&quot;&quot;)</td>
<td>1048576</td>
<td>عدد الصفوف</td>
</tr>
<tr>
<td>3</td>
<td>=A1*A2</td>
<td>17,179,869,184</td>
<td>عدد الخلايا</td>
</tr>
</tbody>
</table>

**seventeen billion one hundred seventy-nine million eight hundred sixty-nine thousand one hundred eighty-four**

**11/2/22**

3rd Year Dent. Tech. Dept
Types of Data in Excel Cell

Cell can contains the following types of Data:

1. **Number**: it could be Decimal and/or comma separator.
2. **Date**: user can select any Date format (Hijri, Gregorian).
3. **Text**: All types (Char, Number and special characters)
4. **Formula**: Date & Time, Statistical, Math & trig, Logical ...(Shift+F3)
5. **Errors**: #DIV/0, #N/A, #NAME?, #NULL!, #NUM!, #REF!, #VALUE!, ######
How to add Comment

1. At any cell, right click (mouse) then
2. Select (Insert Comment) the following picture appear.
3. Put the cursor at the boundary.
4. Right click (mouse)
5. Select (Format Comment)
How to add Picture

5. Select (Colors & Lines)
6. Select fill effect
How to add Picture

7. Select Picture

11/2/22

3rd Year Dent. Tech. Dept
1. From Data at Ribbon select (Data Validation)
2. Select Setting => Any Value
3. Select the appropriate type (Number, Date, Decimal, …)
4. Below a selection of Date type
1. From Data Validation select (Input Message)
2. Type the Title and your Help message
3. Press OK…
Types of Error Alert in Validation

1. STOP

2. Warning

3. Information

11/2/22

3rd Year Dent. Tech. Dept
1. Copy the source cell or a range of cells.
2. Open the *Paste Special* dialog.
3. Select the desired paste option, and
4. click OK or press the Enter key.
How to add Validation

1. From Data at Ribbon select (Data Validation)
2. Select Setting => Any Value
3. Select the appropriate type (Number, Date, Decimal, …)
4. Below a selection of Date type
How to add input Message in Validation

1. From Data Validation select (Input Message)
2. Type the Title and your Help message
3. Press OK…
Types of Error Alert in Validation

1. **STOP**
   - Show error alert after invalid data is entered
   - When user enters invalid data, show this error alert:
     - **Style:** Stop
     - **Title:**
     - **Error message:**

2. **Warning**
   - Show error alert after invalid data is entered
   - When user enters invalid data, show this error alert:
     - **Style:** Warning
     - **Title:**
     - **Error message:**

3. **Information**
   - Show error alert after invalid data is entered
   - When user enters invalid data, show this error alert:
     - **Style:** Information
     - **Title:**
     - **Error message:**

---

3rd Year Dent. Tech. Dept

11/2/22
Example-1 of Circle Invalid Data

<table>
<thead>
<tr>
<th>L</th>
<th>F</th>
<th>E</th>
<th>D</th>
<th>C</th>
<th>B</th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>انتى</td>
<td>اسم الطالب الرباعي</td>
<td>صالح</td>
<td>الصباح</td>
<td>المرحلة</td>
<td>القسم</td>
</tr>
<tr>
<td>1998</td>
<td>ذكر</td>
<td>ابتهال بشار عبد فتاح</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4123</td>
<td>1</td>
</tr>
<tr>
<td>1999</td>
<td>انتى</td>
<td>احمد مسعب محمد جاسم</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4124</td>
<td>2</td>
</tr>
<tr>
<td>1999</td>
<td>ذكر</td>
<td>اسراء احمد فاضل حبيبي</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4125</td>
<td>3</td>
</tr>
<tr>
<td>2001</td>
<td>انتى</td>
<td>اسراء خالد الياس خضر</td>
<td>غير معلوم</td>
<td>المرحلة الثالثة</td>
<td>4126</td>
<td>4</td>
</tr>
<tr>
<td>1999</td>
<td>ذكر</td>
<td>امته فارس حمودي حبيبي</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4127</td>
<td>5</td>
</tr>
<tr>
<td>2001</td>
<td>ذكر</td>
<td>اياس امحمد سعيد عيسى</td>
<td>الصباح</td>
<td>المرحلة السابعة</td>
<td>4128</td>
<td>6</td>
</tr>
<tr>
<td>1995</td>
<td>انتى</td>
<td>نجيب عبد الله عبدالرحمن</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4129</td>
<td>7</td>
</tr>
<tr>
<td>2002</td>
<td>انتى</td>
<td>براء ممتاز يحيى قاسم</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4130</td>
<td>8</td>
</tr>
<tr>
<td>2002</td>
<td>انتى</td>
<td>رابك ميسر محمود عزيز</td>
<td>مسائي</td>
<td>المرحلة الثالثة</td>
<td>4131</td>
<td>9</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>حمزة عمر سامي سعيد</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4132</td>
<td>10</td>
</tr>
<tr>
<td>1996</td>
<td>ذكر</td>
<td>رسل محمود الثور عبدالمجيد</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4133</td>
<td>11</td>
</tr>
<tr>
<td>1998</td>
<td>ذكر</td>
<td>شديد احمد رشيد عويد</td>
<td>الصباح</td>
<td>المرحلة الثانية</td>
<td>4134</td>
<td>12</td>
</tr>
<tr>
<td>2001</td>
<td>انتى</td>
<td>رائد محمد عبده صالح</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4135</td>
<td>13</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زكريا برع سلطان ملوه</td>
<td>خارجي</td>
<td>المرحلة الثالثة</td>
<td>4136</td>
<td>14</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زيد محمد عمر عاصي</td>
<td>الصباح</td>
<td>المرحلة الأولى</td>
<td>4137</td>
<td>15</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زينب عبدالحليم مصطفى محمد</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4138</td>
<td>16</td>
</tr>
<tr>
<td>2001</td>
<td>ذكر</td>
<td>زينب هاني زكر جميط</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4139</td>
<td>17</td>
</tr>
<tr>
<td>2002</td>
<td>انتى</td>
<td>زينه عبدالله اسماعيل عزيز</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4140</td>
<td>18</td>
</tr>
<tr>
<td>2002</td>
<td>انتى</td>
<td>سجي بهاء الدين خالد نافع</td>
<td>مستمر</td>
<td>المرحلة الثالثة</td>
<td>4141</td>
<td>19</td>
</tr>
<tr>
<td>2000</td>
<td>انتى</td>
<td>اسم</td>
<td>الصباح</td>
<td>المرحلة الثالثة</td>
<td>4142</td>
<td>20</td>
</tr>
</tbody>
</table>
### Example-2 of Circle Invalid Data

<table>
<thead>
<tr>
<th>L</th>
<th>F</th>
<th>E</th>
<th>D</th>
<th>C</th>
<th>B</th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td>تاريخ الميلاد</td>
<td>الجنس</td>
<td>اسم الطالب الرباعي</td>
<td>نوع الدراسة</td>
<td>المرحلة</td>
<td>القسم</td>
<td>ت</td>
</tr>
<tr>
<td>2000</td>
<td>أنثى</td>
<td>ابتهال يضارع عبد فتاح</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4123</td>
</tr>
<tr>
<td>1998</td>
<td>ذكر</td>
<td>أحمد صباحي مجيد جاسم</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4124</td>
</tr>
<tr>
<td>1999</td>
<td>أنثى</td>
<td>إسماعيل أحمد قاسم يحيى</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4125</td>
</tr>
<tr>
<td>2001</td>
<td>أنثى</td>
<td>إسماعيل خالد الباش خضر</td>
<td>غير معلوم</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4126</td>
</tr>
<tr>
<td>1999</td>
<td>أنثى</td>
<td>عبد الله فارس حمودي يحيى</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4127</td>
</tr>
<tr>
<td>2001</td>
<td>أنثى</td>
<td>إيناس أبوجمعداد أحمد عيسى</td>
<td>صباحي</td>
<td>السابعة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4128</td>
</tr>
<tr>
<td>1995</td>
<td>أنثى</td>
<td>إيه نجيب عبد الله عبد الرحمن</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4129</td>
</tr>
<tr>
<td>2002</td>
<td>أنثى</td>
<td>براء ممتاز يحيى قاسم</td>
<td>صباحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4130</td>
</tr>
<tr>
<td>2002</td>
<td>أنثى</td>
<td>تيبرك ميسر محمود عزيز</td>
<td>مسائي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4131</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>حمزة عمر سامي سعيد</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4132</td>
</tr>
<tr>
<td>1996</td>
<td>أنثى</td>
<td>رسل محمود فودع عبد الحليم</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4133</td>
</tr>
<tr>
<td>1998</td>
<td>ذكر</td>
<td>رشيد أحمد رشيد عويد</td>
<td>صبحي</td>
<td>الثانية</td>
<td>تقنيات صناعة الأسنان</td>
<td>4134</td>
</tr>
<tr>
<td>2001</td>
<td>أنثى</td>
<td>رشيد محمد محمد صالح</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4135</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زكريا برغ سلطان ملوي</td>
<td>خارجي</td>
<td>الأولى</td>
<td>تقنيات صناعة الأسنان</td>
<td>4136</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زكريا عبد المحسن خراش</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4137</td>
</tr>
<tr>
<td>2002</td>
<td>ذكر</td>
<td>زكريا عبد المحسن خراش</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4138</td>
</tr>
<tr>
<td>2001</td>
<td>أنثى</td>
<td>زكريا عبد الكريم إسماعيل عزيز</td>
<td>مستمر</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4140</td>
</tr>
<tr>
<td>2000</td>
<td>أنثى</td>
<td>سفي بهاء الدين خالد باييف</td>
<td>صبحي</td>
<td>الثالثة</td>
<td>تقنيات صناعة الأسنان</td>
<td>4141</td>
</tr>
</tbody>
</table>

**3rd Year Dent. Tech. Dept**

**11/2/22**
Steps to circle invalid Data

• From main menu select data

• Then Data Validation

• Then Circle invalid Data
HW: Calculate your age in Years, Months and Days.

Method – One (Using built-in Integer command INT)

Sol:
1. Age in days (C1) = current date (A1) – Birthdate (B1) = ; current date TODAY().
2. Take integer value of C1/365 ; D1 = INT(C1/365) ; # of Years.
3. Let E1 = C1 – 365 * D1 ; Fractions of days/year.
4. Let F1 = INT(E1/30) ; # of Months.
5. # of days (G1) = E1 – 30 * F1
Method – Two (Using built-in Date&Time command DATEIF)

Syntax: DATEDIF(start_date, end_date, unit) ; Where:

- start_date = Date of birth (P2);
- end_date (P3) = current date TODAY();
- Unit = “Y” return total number of complete Years in the period.
- Unit = “YM” return total number of complete Months in the period.
- Unit = “MD” return the number of Days in the period.

Sol: If P3 = 7/14/1996, then

- DATEDIF(P2, P3, “Y”) gives 26 Years (P5);
- DATEDIF(P2, P3, “YM”) gives 3 Months and (P6)
- DATEDIF(B2, P3, “MD”) gives 16 Days (P7).

we can use concat built-in function (@) to merge above functions, we get:

=P5&" Years, "&P6&" Months, and "&P7&" days"

Compare the results of both methods,
Next Lecture (Excel functions)

Types (by category)

- Compatibility functions
- Cube functions
- Database functions
- Date and time functions
- Engineering functions
- Financial functions
- Information functions
- Logical functions
- Lookup and reference functions
- Math and trigonometry functions
- Statistical functions
- Text functions
- User defined functions that are installed with add-ins

Types of operations

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation</td>
</tr>
<tr>
<td>&amp;</td>
<td>Concatenation</td>
</tr>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater Than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than Equal To</td>
</tr>
<tr>
<td>=&lt;</td>
<td>Less Than Equal To</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not Equal To</td>
</tr>
</tbody>
</table>

Order of Precedence

1. Exponentiation
2. Multiplication, Division
3. Addition, Subtraction
4. Concatenation
5. Equal to, Greater Than, Less Than, Greater Than Equal To, Less Than Equal To, Not Equal To
TYPES OF EXCEL FUNCTION

Functions and its Types

3rd Year Dent. Tech. Dept

11/7/2022
## Order of operators Precedence

<table>
<thead>
<tr>
<th>Operator</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>1</td>
</tr>
<tr>
<td>/</td>
<td>2</td>
</tr>
<tr>
<td>*</td>
<td>2</td>
</tr>
<tr>
<td>+</td>
<td>3</td>
</tr>
<tr>
<td>-</td>
<td>3</td>
</tr>
<tr>
<td>&amp;</td>
<td>4</td>
</tr>
<tr>
<td>=</td>
<td>5</td>
</tr>
<tr>
<td>==</td>
<td>5</td>
</tr>
<tr>
<td>&gt;</td>
<td>5</td>
</tr>
<tr>
<td>&lt;</td>
<td>5</td>
</tr>
</tbody>
</table>

1. `( ^ )` Exponential
2. `( /, *)` Division and Multiplication
3. `( +, - )` Addition and Subtraction
4. `( & )` Concatenation
5. `( =, >, <, <=, >=, <> )` Relational operators

Any operators inside Parentheses ( ) (round brackets) must be evaluated first then this rule applied.
Function and Formula in Excel

مساحة الدائرة = نصف القطر تربيع في النسبة المئوية (pi)

Diameter = 20 Cm

مساحة الدائرة = نصف القطر تربيع في النسبة المئوية (pi)
1. Shift+F3 (search for function)
2. From Formula Tab
3. Argument could be (zero,1,2,...n)
4. Insert from current sheet or another one
1. Double click the cell that contains the data that you want to edit.

2. Click the cell that contains the data that you want to edit, and then press F2.

3. Click the cell that contains the data that you want to edit, and then click anywhere in the formula bar.
Types of Cell Address

Three types of cell Address:
1. Relative (address change in relation of cell position)
2. Absolut ($ sign) lock the cell, no change.
3. Mixed (Partially Absolute)
Cell Reference

What is a range reference in Excel?

The range A1:D2 includes 8 cells from A1 through D2.

When copied and filled to other cells, relative and absolute references behave differently
The dollar sign (\$) is used to make references absolute. It has three different states:

- **$A1**: Allows the row reference to change, but not the column reference.
- **A$1**: Allows the column reference to change, but not the row reference.
- **$A$1**: Allows neither the column nor the row reference to change.
تجربة عمل
Argument could be (zero, 1, 2, ... n) elements. Argument is the material between the two brackets ( ) after the function name.
Example:

**Today()** ... Zero argument.

**NOT(TRUE)** ... One single Argument

**SUM(1,2,4,10)**  (n) Arguments

**SUM(A1:A10,B5:B12)**

**IF(logical_test,[value_if_true],[value_if_false])**

Up to 64 nested if

Most arguments are required, but some are optional. In Excel, optional arguments are denoted with square brackets.

{ } for array

Control + Shift + Enter
### AND, OR, NOT & XOR

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>AND</th>
<th>OR</th>
<th>XOR</th>
<th>NOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>TRUE</td>
</tr>
<tr>
<td>FALSE</td>
<td>TRUE</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

### Logic Diagrams

- **AND**
  - Circuit diagram
  - Truth table:
    - A: 0 0 0 0
    - B: 0 1 1 1
    - AND: 0 0 1 1

- **OR**
  - Circuit diagram
  - Truth table:
    - A: 1 0 0 1
    - B: 1 0 1 1
    - OR: 1 0 1 1

- **NOT**
  - Circuit diagram
  - Truth table:
    - A: 0 0 1 1
    - NOT: 1 1 0 0

- **XOR**
  - Circuit diagram
  - Truth table:
    - A: 1 0 1 0
    - B: 0 1 0 1
    - XOR: 1 1 1 0

**Notes:**
- 11/7/2022
- 3rd Year Dent. Tech. Dept
تطبيق عمل
Math FUNCTION

**INT()**

*What it Does:* Rounds a number down to the nearest integer.

*Syntax:* 
`=INT(number)`

**MOD()**

*What it Does:* Returns the remainder after number is divided by divisor. The result has the same sign as divisor.

*Syntax:* 
`=MOD(number, divisor)`

**RAND()**

*What it Does:* Returns an evenly distributed random real number greater than or equal to 0 and less than 1. A new random real number is returned every time the worksheet is calculated.

*Syntax:* 
`=RAND()`

**ROUND()**

*What it Does:* Rounds a number to a specified number of digits.

*Syntax:* 
`=ROUND(number, num_digits)`

**RANDBETWEEN()**

*What it Does:* Returns a random integer number between the numbers you specify. A new random integer number is returned every time the worksheet is calculated.
Math FUNCTION

SUM()

What it Does:
Adds all the numbers that you specify as arguments

Syntax:
=SUM(number1,[number2],...)

SUMIF()

What it Does:
Adds all the values in a range that meet the specified criteria

Syntax:
=SUMIF(range, criteria, [sum_range])

SUMIFS()

What it Does:
Adds the cells in a range that meet multiple criteria

Syntax:
=SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)

SUMPRODUCT()

What it Does:
Multiplies corresponding components in the given arrays, and returns the sum of those products

Syntax:
=SUMPRODUCT(array1, [array2], [array3], ...)

11/7/2022
3rd Year Dent. Tech. Dept
<table>
<thead>
<tr>
<th></th>
<th>STATISTICAL FUNCTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>COUNT</td>
</tr>
<tr>
<td>2.</td>
<td>COUNTA</td>
</tr>
<tr>
<td>3.</td>
<td>COUNTBLANK</td>
</tr>
<tr>
<td>4.</td>
<td>COUNTIF</td>
</tr>
<tr>
<td>5.</td>
<td>COUNTIFS</td>
</tr>
<tr>
<td>6.</td>
<td>AVERAGE</td>
</tr>
<tr>
<td>7.</td>
<td>AVERAGEIF</td>
</tr>
<tr>
<td>8.</td>
<td>AVERAGEIFS</td>
</tr>
<tr>
<td>9.</td>
<td>LARGE</td>
</tr>
<tr>
<td>10.</td>
<td>SMALL</td>
</tr>
<tr>
<td>11.</td>
<td>MIN</td>
</tr>
<tr>
<td>12.</td>
<td>MAX</td>
</tr>
<tr>
<td>13.</td>
<td>RANK</td>
</tr>
<tr>
<td>14.</td>
<td>MINIFS</td>
</tr>
<tr>
<td>15.</td>
<td>MAXIFS</td>
</tr>
<tr>
<td>16.</td>
<td>MEDIAN</td>
</tr>
<tr>
<td>17.</td>
<td>MODE</td>
</tr>
<tr>
<td>18.</td>
<td>STANDARD DEVIATION</td>
</tr>
</tbody>
</table>

11/7/2022
3rd Year Dent. Tech. Dept
<table>
<thead>
<tr>
<th>Country</th>
<th>Little Dip</th>
<th>Dip</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>4.50</td>
<td>200</td>
<td>900.00</td>
</tr>
<tr>
<td>France</td>
<td>5.00</td>
<td>300</td>
<td>1500.00</td>
</tr>
<tr>
<td>Japan</td>
<td>6.00</td>
<td>400</td>
<td>2400.00</td>
</tr>
<tr>
<td>China</td>
<td>7.00</td>
<td>500</td>
<td>3500.00</td>
</tr>
<tr>
<td>Italy</td>
<td>8.00</td>
<td>600</td>
<td>4800.00</td>
</tr>
</tbody>
</table>

**Revenue by Country**
ISBLANK()  Check if the value is BLANK
ISERROR()  Check if the value is ERROR
ISNA() Check if the value is #N/A
ISNUMBER()  Check if the value is NUMBER
ISODD() Check if the value is ODD
ISEVEN() Check if the value is EVEN
ISTEXT()  Check if the value is TEXT
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISNONTEXT()</td>
<td>Check if the value is <em>not a text</em></td>
</tr>
<tr>
<td>ISERR()</td>
<td>Returns TRUE if the given value is an error (except N/A) and vice versa</td>
</tr>
<tr>
<td>ISREF()</td>
<td>Check if the value is #N/A</td>
</tr>
<tr>
<td>ISOWEEKNUM()</td>
<td>Check if the value is NUMBER</td>
</tr>
<tr>
<td>ISFORMULA()</td>
<td>Check if the value is ODD</td>
</tr>
</tbody>
</table>
IFERROR checks a formula, and if it evaluates to an error, returns another value you specify; otherwise, returns the result of the formula.

Examples:

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>4</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>24</td>
<td>0</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>N/A#</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>25</td>
<td>6</td>
<td>4.17</td>
<td></td>
</tr>
</tbody>
</table>
### Example of ISNA Function

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>=VLOOKUP(10,A1:A7,1,0)</td>
<td>=ISNA(B2)</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>=ISNA(A3)</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Excel Spreadsheets

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>#N/A</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>FALSE</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td></td>
</tr>
</tbody>
</table>

11/7/2022

3rd Year Dent. Tech. Dept
Types of Excel Function
Order of operators Precedence

1. (^) Exponential
2. (/,* ) Division and Multiplication
3. (+,- ) Addition and Subtraction
4. ( & ) Concatenation
5. (=,>,<,<=,>=,<> ) Relational operators

Any operators inside Parentheses ( ) (round brackets) must be evaluated first then this rule applied.
Function and Formula in Excel

**Function and Formula in Excel**

**3rd Year Dent. Tech. Dept**

11/14/22

**Formula for Calculating the Area of a Triangle**

\[ \text{Area} = \frac{1}{2} \times \text{base} \times \text{height} \]

**Formula for Calculating the Area of a Circle**

\[ \text{Area} = \pi r^2 \]

**Example**

Given a triangle with base 60 and height 30, the area can be calculated as:

\[ \text{Area} = \frac{1}{2} \times 60 \times 30 = 900 \]

**Example**

Given a circle with a diameter of 20 cm, the radius is 10 cm.

\[ \text{Area} = \pi \times (10)^2 = 100\pi \]

**Note:**

The area of the triangle is 900 square units, and the area of the circle is 100\(\pi\) square units.

**Translation:**

مساحة الدائرة = نصف القطر تربيع في النسبة الثابتة (\(\pi\))
1. Shift+F3 (search for function)
2. From Formula Tab
3. Argument could be (zero,1,2,…n)
4. Insert from current sheet or another one

=SUM(A1,A2,G1:G20)

Argument
1. Double click the cell that contains the data that you want to edit.

2. Click the cell that contains the data that you want to edit, and then press F2.

3. Click the cell that contains the data that you want to edit, and then click anywhere in the formula bar.
Three types of cell Address:
1. Relative (address change in relation of cell position)
2. Absolut ($ sign) lock the cell, no change.
3. Mixed (Partially Absolute)
What is a range reference in Excel?

The range A1:D2 includes 8 cells from A1 through D2.

When copied and filled to other cells, relative and absolute references behave differently.
The dollar sign ($) is used to make references absolute. It has three different states:

<table>
<thead>
<tr>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A1</td>
<td>Allows the row reference to change, but not the column reference.</td>
</tr>
<tr>
<td>A$1</td>
<td>Allows the column reference to change, but not the row reference.</td>
</tr>
<tr>
<td>$A$1</td>
<td>Allows neither the column nor the row reference to change.</td>
</tr>
</tbody>
</table>
لنتجه عملًا
Argument could be (zero, 1, 2, ... n) elements. Argument is the material between the two brackets () after the function name.
Example:

**Today()** ... Zero argument.

**NOT(TRUE)**....One single Argument

**SUM(1,2,4,10)**  (n) Arguments

**SUM(A1:A10,B5:B12)**

**IF(logical_test,[value_if_true],[value_if_false])**

Up to 64 nested if

Most arguments are required, but some are optional. In Excel, optional arguments are denoted with square brackets.

Control + Shift + Enter
## AND, OR, NOT & XOR

<table>
<thead>
<tr>
<th></th>
<th></th>
<th><strong>AND</strong></th>
<th><strong>OR</strong></th>
<th><strong>XOR</strong></th>
<th><strong>NOT</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>FALSE*1</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>TRUE</td>
</tr>
<tr>
<td>TRUE*1</td>
<td>TRUE</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>TRUE</td>
<td>FALSE</td>
<td>FALSE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
</tr>
<tr>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

### Logic Diagrams

1. **XOR** (exclusive OR): ![XOR gate diagram]
2. **AND** gate: ![AND gate diagram]
3. **OR** gate: ![OR gate diagram]
4. **NOT** gate: ![NOT gate diagram]

### Boolean Expressions

- **XOR** expression: $z = xy$
- **OR** expression: $y = a + b$
- **AND** expression: $q = ab + \overline{a}b$

### Truth Tables

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th><strong>AND</strong></th>
<th><strong>OR</strong></th>
<th><strong>XOR</strong></th>
<th><strong>NOT</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

*Notes:*
- *FALSE* and *TRUE* are used to represent boolean values.
- *AND* is true only when both inputs are true.
- *OR* is true if at least one input is true.
- *XOR* is true if exactly one input is true.
- *NOT* inverts the input value.
Let's GO

نَتْحَبْ عَالَى
**AND**: Returns TRUE if ALL argument is TRUE. A single AND function can test up to 255.

**OR**: Returns TRUE if any argument is TRUE.

**NOT**: Reverses the logic of its argument.

**XOR**: Returns TRUE if the number of TRUE inputs is even.

**IF**: make logical comparisons between a value and what you expect. IF statement can have two results. The first result is: if your comparison is True, the second if your comparison is False.
Begin

Read variable A1

If(A1>=50)

FAIL

FALSE

If(A1>=50)

TRUE

PASS

End

3rd Year Dent. Tech. Dept

11/14/22
Format of Nested IF statement

\[
\text{IF}(\text{condition1, result1, IF(condition2, result2, IF(condition3, result3, result4)))}
\]

Test condition1, if TRUE - return result1, if FALSE - test condition2, if TRUE - return result2, if FALSE - test condition3, if TRUE - return result3, if FALSE - return result4

Ex:

test if DEPTCODE in (D1)="ص" PRINT ص.اسنان,
if (D1)="م" PRINT مختبرات,
if (D1)="ت" PRINT تخدير,
if (D1)="ب" PRINT بصريات,
ELSE
PRINT تأكد من رمز القسم
Format of Nested IF statement

3rd Year Dent. Tech. Dept
=IF(D1="ب","ت"=1,IF(D1="ص",ص.اسنان","ص.مختبرات"=1,IF(D1="م",IF(D1="ت",ب"=1,IF(D1="ص"=1,"م"=1,IF(D1="ص","ص"=1,ص.اسنان"="ص.مختبرات"1))1))))("تأكد من رمز القسم"=" بصريات"="ب"=1,IF(D1="ب"=1,IF(D1="ع"=1,IF(D1="ص"=1,ص.اسنان"="ص.مختبرات"1))1))
### Combine IF statement with AND & OR

**استخدم الجدول أدناه لكتابة دالة لطبع:**

<table>
<thead>
<tr>
<th>الجنس</th>
<th>الحضور</th>
<th>يتمطبع</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>F</td>
<td>غائبة</td>
</tr>
<tr>
<td>1</td>
<td>A</td>
<td>حاضرة</td>
</tr>
<tr>
<td>3</td>
<td>T</td>
<td>غائب</td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>حاضر</td>
</tr>
</tbody>
</table>

1. غائبة (إذا B2=X و A2=F)
2. حاضرة (إذا B2=A و A2=F)
3. غائب (إذا B2=X و A2=T)
4. حاضر (إذا B2=A و A2=T)
Example of using IF statement with AND

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Gender</td>
<td>Attendance</td>
</tr>
<tr>
<td>2</td>
<td>F</td>
<td>A</td>
</tr>
<tr>
<td>3</td>
<td>T</td>
<td>X</td>
</tr>
<tr>
<td>4</td>
<td>T</td>
<td>A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>الجنس</th>
<th>الحضور</th>
<th>B</th>
<th>يطبع</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>F</td>
<td>X</td>
<td></td>
<td>غائبة</td>
</tr>
<tr>
<td>3</td>
<td>F</td>
<td>A</td>
<td></td>
<td>حاضرة</td>
</tr>
<tr>
<td>4</td>
<td>T</td>
<td>X</td>
<td></td>
<td>غائب</td>
</tr>
<tr>
<td>11</td>
<td>T</td>
<td>A</td>
<td></td>
<td>حاضر</td>
</tr>
</tbody>
</table>

3rd Year Dent. Tech. Dept
11/14/22
**Math FUNCTION**

**INT()**

*What it Does:* Rounds a number down to the nearest integer.

*Syntax:* 

```excel
=INT(number)
```

**MOD()**

*What it Does:* Returns the remainder after number is divided by divisor. The result has the same sign as divisor.

*Syntax:* 

```excel
=MOD(number, divisor)
```

**RAND()**

*What it Does:* Returns an evenly distributed random real number greater than or equal to 0 and less than 1. A new random real number is returned every time the worksheet is calculated.

*Syntax:* 

```excel
=RAND()
```

**ROUND()**

*What it Does:* Rounds a number to a specified number of digits.

*Syntax:* 

```excel
=ROUND(number, num_digits)
```

**RANDBETWEEN()**

*What it Does:* Returns a random integer number between the numbers you specify. A new random integer number is returned every time the worksheet is calculated.
**SUM()**

*What it Does:* Adds all the numbers that you specify as arguments.

*Syntax:* 

```
=SUM(number1,[number2],...)
```

---

**SUMIF()**

*What it Does:* Adds all the values in a range that meet the specified criteria.

*Syntax:* 

```
=SUMIF(range, criteria, [sum_range])
```

---

**SUMIFS()**

*What it Does:* Adds the cells in a range that meet multiple criteria.

*Syntax:* 

```
=SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)
```

---

**SUMPRODUCT()**

*What it Does:* Multiplies corresponding components in the given arrays, and returns the sum of those products.

*Syntax:* 

```
=SUMPRODUCT(array1, [array2], [array3], ...)
```
STATISTICAL FUNCTIONS

1. COUNT
2. COUNTA
3. COUNTBLANK
4. COUNTIF
5. COUNTIFS

6. AVERAGE
7. AVERAGEIF
8. AVERAGEIFS

9. LARGE
10. SMALL
11. MIN
12. MAX
13. RANK

14. MINIFS
15. MAXIFS

16. MEDIAN
17. MODE
18. STANDARD DEVIATION

11/14/22
3rd Year Dent. Tech. Dept
Lets GO شروع عمل
### IS FORMULA in EXCEL

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISBLANK()</td>
<td>Check if the value is BLANK</td>
</tr>
<tr>
<td>ISERROR()</td>
<td>Check if the value is ERROR</td>
</tr>
<tr>
<td>ISNA()</td>
<td>Check if the value is #N/A</td>
</tr>
<tr>
<td>ISNUMBER()</td>
<td>Check if the value is NUMBER</td>
</tr>
<tr>
<td>ISODD()</td>
<td>Check if the value is ODD</td>
</tr>
<tr>
<td>ISEVEN()</td>
<td>Check if the value is EVEN</td>
</tr>
<tr>
<td>ISTEXT()</td>
<td>Check if the value is TEXT</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ISNONTEXT()</td>
<td>Check if the value is <em>not a text</em></td>
</tr>
<tr>
<td>ISERR()</td>
<td>Returns TRUE if the given value is an error (except N/A) and vice versa</td>
</tr>
<tr>
<td>ISREF()</td>
<td>Check if the value <em>is a reference or not</em></td>
</tr>
<tr>
<td>ISOWEEKNUM()</td>
<td>Return the ISO week number number of the year for the given date value</td>
</tr>
<tr>
<td>ISFORMULA()</td>
<td>Checks to see if a value is a formula</td>
</tr>
</tbody>
</table>
IFERROR (value, value_if_error)

IFERROR checks a formula, and if it evaluates to an error, returns another value you specify; otherwise, returns the result of the formula.

Examples:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>4</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>24</td>
<td>0</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>N/A#</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>25</td>
<td>6</td>
<td>4.17</td>
<td></td>
</tr>
</tbody>
</table>
Example of `ISNA` Function

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>=VLOOKUP(10,A1:A7,1,0)</td>
<td>=ISNA(B2)</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>=ISNA(A3)</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>#N/A</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>TRUE</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>FALSE</td>
</tr>
<tr>
<td>5</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td></td>
</tr>
</tbody>
</table>

11/14/22
3rd Year Dent. Tech. Dept
شکر
We can combine more than one logical function in a formula like:

\[
\text{IF with AND, OR and not NOT}
\]
Format of Nested IF statement
IFS statement instead of Nested IF statements

= IFS(D1="診療", "ب", D1="診音", "س", D1="検査", "م", D1="治療", "ت", TRUE, "確認の記号")

ONLY in Excel 2019 and above

Use your Mobil to add abbreviations to all Alnoor Departments

= IFS(D1="診療", "診療", D1="診音", "診音", D1="検査", "検査", D1="治療", "治療", TRUE, "確認の記号")

12/5/2022
3rd Year Dent. Tech. Deptartment
=IFS(D1="ا.د.ت. في", "تم", D1="المختبرات", "تم", D1="الخدمة", "تم", D1="التدخير", "تم", D1="للتأكيد", "تم", D1="الرمز", "تم", D1="السونار", "تم")

3rd Year Dent. Tech. Department
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INT()</td>
<td>Integer of a number</td>
</tr>
<tr>
<td>2. RAND()</td>
<td>Random number between 0 and 1</td>
</tr>
<tr>
<td>3. MOD()</td>
<td>Integer quotient of division</td>
</tr>
<tr>
<td>4. ROUND()</td>
<td>Rounds a number to nearest integer</td>
</tr>
<tr>
<td>5. ROUNDUP()</td>
<td>Rounds a number up</td>
</tr>
<tr>
<td>6. ROUNDDOWN()</td>
<td>Rounds a number down</td>
</tr>
<tr>
<td>7. MROUND()</td>
<td>Rounds a number to nearest round</td>
</tr>
<tr>
<td>8. CEILING()</td>
<td>Rounds a number up</td>
</tr>
<tr>
<td>9. FLOOR()</td>
<td>Rounds a number down</td>
</tr>
<tr>
<td>10. RANDBETWEEN()</td>
<td>Random number between two numbers</td>
</tr>
</tbody>
</table>

Each function has its own argument (number of parameters).
**INT() , MOD() FUNCTIONS**

**WHAT IS:**

- **INT(-8.45)**,
- **INT(PI())**

**INT()**

Rounds a number **down** to the nearest integer

**Syntax:**

=INT(NUMBER)

**MOD()**

- **What it Does:**
  Returns the remainder after number is divided by divisor. The result has the **same sign** as divisor.

**Syntax:**

=MOD(number, divisor)

- **if divisor is negative then:**
  - a mod b = b-Remainder,
  - 5 mod -3=
  - 5/3 = 1 and remainder 2,
  - So 3-2=1
**RAND() Function**

What it Does:

Returns an evenly distributed random real number greater than or equal to 0 and less than 1. A new random real number is returned every time the worksheet is calculated.

Syntax:

```
=RAND()
```

### Example

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>=Rand()</td>
<td>0.87509731</td>
</tr>
<tr>
<td>=Rand()</td>
<td>0.7667742</td>
</tr>
<tr>
<td>=Rand()</td>
<td>0.05949073</td>
</tr>
<tr>
<td>=Rand()</td>
<td>0.99508906</td>
</tr>
</tbody>
</table>
RANDBETWEEN() FUNCTION

What it Does:
Returns a random integer number between the numbers you specify. A new random integer number is returned every time the worksheet is calculated.

Syntax:
=RANDBETWEEN(bottom, top)

Two Parameters

<table>
<thead>
<tr>
<th>Data Used in Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>59</td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>RANDBETWEEN(A2,A3)</td>
<td>59</td>
</tr>
<tr>
<td>RANDBETWEEN(0,49)</td>
<td>3</td>
</tr>
<tr>
<td>RANDBETWEEN(5,8)</td>
<td>7</td>
</tr>
<tr>
<td>RANDBETWEEN(-32,0)</td>
<td>-26</td>
</tr>
</tbody>
</table>
ROUND() FUNCTION

What it Does:
Rounds a number to a specified number of digits

Syntax:
=ROUND(number, num_digits)

Two Parameters

Round(148.55, -2) = ?

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND(42.52, 1)</td>
<td>42.5</td>
<td>Rounds to 1 decimal place</td>
</tr>
<tr>
<td>ROUND(42.55, 1)</td>
<td>42.6</td>
<td>Rounds to 1 decimal place</td>
</tr>
<tr>
<td>ROUND(42.55, 0)</td>
<td>43</td>
<td>Rounds to 0 decimal place</td>
</tr>
<tr>
<td>ROUND(42.45, 0)</td>
<td>42</td>
<td>Rounds to 0 decimal place</td>
</tr>
<tr>
<td>ROUND(42.55, -1)</td>
<td>40</td>
<td>Rounds to -1 decimal place</td>
</tr>
<tr>
<td>ROUND(178.45, -2)</td>
<td>200</td>
<td>Rounds to -2 decimal place</td>
</tr>
</tbody>
</table>
ROUNDUP() FUNCTION

Syntax:
ROUNDUP(N, digits)

- ROUNDUP behaves like ROUND, except that it always rounds a number up.
- If digits is greater than zero, then number is rounded up to the specified number of decimal places.
- If digits is 0, then number is rounded up to the nearest integer.
- If digits is less than 0, then number is rounded up to the left of the decimal point.

=ROUNDUP(7815.75431, -2) GIVES 7900
## ROUNDP() FUNCTION Examples

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUNDP(42.52,1)</td>
<td>42.6</td>
<td>Rounds to 1 decimal place</td>
</tr>
<tr>
<td>ROUNDP(42.55,1)</td>
<td>42.6</td>
<td>Rounds to 1 decimal place</td>
</tr>
<tr>
<td>ROUNDP(42.55,0)</td>
<td>43</td>
<td>Rounds to 0 decimal place</td>
</tr>
<tr>
<td>ROUNDP(42.45,0)</td>
<td>43</td>
<td>Rounds to 0 decimal place</td>
</tr>
<tr>
<td>ROUNDP(42.55,-1)</td>
<td>50</td>
<td>Rounds to -1 decimal place</td>
</tr>
<tr>
<td>ROUNDP(178.55,-2)</td>
<td>200</td>
<td>Rounds to -2 decimal place</td>
</tr>
<tr>
<td>ROUNDP(PI(),7)</td>
<td>3.1415927</td>
<td>Rounds PI to 7 decimal place</td>
</tr>
</tbody>
</table>

\[ \text{PI()} = 3.141592654 \]
syntax:

Rounddown (N, n_digits)

It behaves like round, except that it always rounds a number (N) down.

1. If n_digits is greater than zero, then number is rounded down to the specified number of decimal places.
2. If n_digits is 0, then number is rounded down to the nearest integer.
3. If n_digits is less than 0, then number is rounded down to the left of the decimal point.

=Rounddown (7815.75431, -2) gives 7800
MROUND() FUNCTION

Syntax:

=MROUND(number, multiple)

It uses the following arguments:

Number: This is the number that needs to be rounded.
Multiple: This is the multiple to which we want to round a number.

=\text{MROUND}(7815.75431, -2) \text{ GIVES 7800}

What is the result of:

\begin{align*}
\text{=MROUND}(7815.75431, -2) \text{ GIVES 7800} \\
\text{=MROUND}(17,5) \text{ GIVES 15} \\
\text{=MROUND}(18,5) \text{ GIVES 20} \\
\text{MROUND}(\pi(),2) \text{ GIVES 4} \\
\text{=MROUND}(25.4,3) \\
\text{=MROUND}(25.6,3)
\end{align*}
The CEILING() function rounds a number down, toward zero, to the nearest multiple of significance. Here are some examples:

- \( \text{CEILING}(16.001,1) \) gives 17
- \( \text{CEILING}(16.001,2) \) gives 18
- \( \text{CEILING}(16.001,3) \) gives 18
- \( \text{CEILING}(16.001,4) \) gives 20
- \( \text{CEILING}(16.999,1) \) gives 17
- \( \text{CEILING}(25.4,3) \)
- \( \text{CEILING}(\pi(),1) \)
- \( \text{CEILING}(\pi(),2) \)
- \( \text{CEILING}(\pi(),4) \)
- \( \text{CEILING}(\pi(),7) \)
FLOOR() FUNCTION

Syntax:
FLOOR(number, significance)

Rounds number down, toward zero, to the nearest multiple of significance.

= FLOOR(16.999, 1) GIVES 16

What is the result of:
= FLOOR(25.4, 1)
= FLOOR(25.4, 2)
= FLOOR(25.4, 3)
= FLOOR(25.4, 7)

<table>
<thead>
<tr>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLOOR(42.001, 1)</td>
<td>42</td>
</tr>
<tr>
<td>FLOOR(42.999, 1)</td>
<td>42</td>
</tr>
<tr>
<td>FLOOR(pi(), 1)</td>
<td>3</td>
</tr>
</tbody>
</table>
IFERROR function, to handle errors in a formula.
**IFERROR** (value, value_if_error)

**IFERROR** checks a formula, and if it evaluates to an error, returns another value you specify; otherwise, returns the result of the formula.

**Syntax**

**IFERROR**(value, value_if_error)

value : The argument that is checked for an error.
value_if_error: The value to return if the formula evaluates to an error.
Math FUNCTION (Part – Two)

**SUM()**

*What it Does:* Adds all the numbers that you specify as arguments

*Syntax:*

=SUM(number1,[number2],...)

**SUMIF()**

*What it Does:* Adds all the values in a range that meet the specified criteria

*Syntax:*

=SUMIF(range, criteria, [sum_range])

**SUMIFS()**

*What it Does:* Adds the cells in a range that meet multiple criteria

*Syntax:*

=SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)

**SUMPRODUCT()**

*What it Does:* Multiplies corresponding components in the given arrays, and returns the sum of those products

*Syntax:*

=SUMPRODUCT(array1, [array2], [array3], ...)

12/11/2022

3rd Year Dent. Tech. Department
Then Lecture - 10
STATISTICAL FUNCTIONS (Lect. 10)

1. COUNT
2. COUNTA
3. COUNTBLANK
4. COUNTIF
5. COUNTIFS

6. AVERAGE
7. AVERAGEIF
8. AVERAGEIFS

9. LARGE
10. SMALL
11. MIN
12. MAX
13. RANK
14. MINIFS
15. MAXIFS
16. MEDIAN
17. MODE
18. STANDARD DEVIATION

3rd Year Dent. Tech. Department

12/11/2022
Then
Lecture - 11

تطبيق عملي
### Information Function: IS FORMULA in EXCEL (Lect-11)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISBLANK()</td>
<td>Check if the value is BLANK</td>
</tr>
<tr>
<td>ISERROR()</td>
<td>Check if the value is ERROR</td>
</tr>
<tr>
<td>ISNA()</td>
<td>Check if the value is #N/A</td>
</tr>
<tr>
<td>ISNUMBER()</td>
<td>Check if the value is NUMBER</td>
</tr>
<tr>
<td>ISODD()</td>
<td>Check if the value is ODD</td>
</tr>
<tr>
<td>ISEVEN()</td>
<td>Check if the value is EVEN</td>
</tr>
<tr>
<td>ISTEXT()</td>
<td>Check if the value is TEXT</td>
</tr>
</tbody>
</table>

**3rd Year Dent. Tech. Department**

**Date:** 12/11/2022
### Information Function: `IS FORMULA in EXCEL – Cont...`

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ISNONTEXT()</code></td>
<td>Check if the value is not a text</td>
</tr>
<tr>
<td><code>ISERR()</code></td>
<td>Returns TRUE if the given value is an error (except N/A) . Otherwise, it will return FALSE.</td>
</tr>
<tr>
<td><code>ISREF()</code></td>
<td>If value is a reference, it will return TRUE. Otherwise, it will return FALSE.</td>
</tr>
<tr>
<td><code>ISFORMULA()</code></td>
<td>Checks whether there is a reference to a cell that contains a formula, and returns TRUE or FALSE.</td>
</tr>
</tbody>
</table>
STATISTICAL FUNCTIONS

Functions and its Types
STATISTICAL FUNCTIONS (Lect. 10)

1. COUNT
2. COUNTA
3. COUNTBLANK
4. COUNTIF
5. COUNTIFS
6. AVERAGE
7. AVERAGEIF
8. AVERAGEIFS
9. LARGE
10. SMALL
11. MIN
12. MAX
13. RANK
14. MINIFS
15. MAXIFS
16. MEDIAN
17. MODE
18. STANDARD DEVIATION
COUNT functions

COUNT function counts cells that contain only numbers, but COUNTA function counts cells that are not blank, including numbers. Date and Time values are stored as serial numbers in Excel so these values are counted in both of these functions.

COUNT function does not count logical values (TRUE and FALSE), but COUNTA function counts these values.

COUNTBLANK function counts the number of empty cells in a range of cells.

Syntax:

\[ \text{COUNT/A/BLANK( range)} \]
COUNTIF function **counts** the # of cells that meet **ONLY ONE** criterion.

COUNTIFS function applies criteria to cells across **multiple** ranges and counts the number of times all criteria are met.

**Syntax**

COUNTIF(criteria range, criteria)

COUNTIFS(criteria range1, criteria1,[criteria range2, criteria2,]...)

COUNTIF(D2:D161,"M") → 73  
COUNTIF(D2:D161, "F") → 87  
COUNTIFS(H2:H161,"بغداد",D2:D161,"F") → عدد طالبات بغداد 14
**AVERAGE functions**

**AVERAGE** returns the average (arithmetic **Mean**) of the arguments.

**AVERAGEIF** calculates the **average** of a range based on true or false condition **ONLY ONE** criteria.

**AVERAGEIFS** calculates the **average** of a range based on **one or more** **true or false** condition.

Syntax:  
AVERAGE(range)  
AVERAGEIF(criteria range, criteria, sum range)  
AVERAGEIFS(sum range ,criteria range1, criteria1, [criteria range2, criteria2],...)
**LARGE & SMALL functions**

**LARGE** Returns the *Kth* largest value in a data set.

**SMALL** Returns the *kth smallest value* in a data set.

If array is empty, LARGE/SMALL returns the #NUM! error value.

*If* \(k\leq 0\) *or if* \(k > n\)  greater than the number of data points, LARGE/SMALL returns the #NUM! error value.

**Syntax:** LARGE/SMALL(array, k)

If \(n\) is the number of data points in a range, then LARGE(array, 1) returns the largest value, and LARGE(array, n) returns the smallest value.

If \(n\) is the number of data points in array, SMALL(array, 1) equals the smallest value, and SMALL(array, n) equals the largest value.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISBLANK()</td>
<td>Check if the value is BLANK</td>
</tr>
<tr>
<td>ISERROR()</td>
<td>Check if the value is ERROR</td>
</tr>
<tr>
<td>ISNA()</td>
<td>Check if the value is #N/A</td>
</tr>
<tr>
<td>ISNUMBER()</td>
<td>Check if the value is NUMBER</td>
</tr>
<tr>
<td>ISODD()</td>
<td>Check if the value is ODD</td>
</tr>
<tr>
<td>ISEVEN()</td>
<td>Check if the value is EVEN</td>
</tr>
<tr>
<td>ISTEXT()</td>
<td>Check if the value is TEXT</td>
</tr>
</tbody>
</table>
Information Function: **IS FORMULA in EXCEL – Cont...**

- **ISNONTEXT()**: Check if the value is not a text

- **ISERR()**: Returns TRUE if the given value is an error (except N/A). Otherwise, it will return FALSE.

- **ISREF()**: If value is a reference, it will return TRUE. Otherwise, it will return FALSE.

- **ISFORMULA()**: Checks whether there is a reference to a cell that contains a formula, and returns TRUE or FALSE.
12/18/2022

3rd Year Dent. Tech. Department
Information Function

Functions and its Types
Information Function:  IS FORMULA in EXCEL (Lect-12)

- ISBLANK(): Check if the value is BLANK
- ISERROR(): Check if the value is ERROR
- ISNA(): Check if the value is #N/A
- ISNUMBER(): Check if the value is NUMBER
- ISODD(): Check if the value is ODD
-ISEVEN(): Check if the value is EVEN
- ISTEXT(): Check if the value is TEXT
ISNONTEXT() - Check if the value is not a text
ISERR() - Returns TRUE if the given value is an error (except N/A). Otherwise, it will return FALSE
ISREF() - If value is a reference, it will return TRUE. Otherwise, it will return FALSE
ISFORMULA() - Checks whether there is a reference to a cell that contains a formula, and returns TRUE or FALSE
Excel stores dates in a serial date format. It represents the days from January 1, 1900. So January 1, 1900 would be the serial number 1 and January 1, 2023 would be 44927, as it is 44927 days after January 1, 1900.

**ISOWEEKNUM()**: used for finding out the ISO week number of the year for the given date value (e.g.: `ISOWEEKNUM(30)` gives week number 5 of 52 weeks in the year).